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1 Introduction 
The purpose of this guide is to explain the procedure involved in generating reports from the SIMPLer databases 
using an external reporting package. In this guide, we will use the commercial reporting package – Crystal Reports 
– to illustrate how easily all manner of reports can be generated. 

We recommend that you use this document in conjunction with Azotel document 10025 SIMPLer Database 
Structure, which documents SIMPLer’s database structure. 

While we only describe the procedure involved with generating external reports using Crystal Reports, the idea is 
the same if you want to use an alternative reporting package. For example, Jasper Reports is a free open source 
alternative that can be downloaded from http://jasperforge.org. 

For addition assistance with Crystal Reports, please refer to the manual that was provided with the package. For 
assistance in regard to the SIMPLer database structure, please contact Azotel and we will be happy to help. 
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2 Initial Set Up 
2.1 Install Crystal Reports 
Install Crystal Reports and accept all default options. 

2.2 Install PostgreSQL ODBC Driver (psqlODBC) 
In order for Crystal Reports to pull data from the SIMPLer server, a special ODBC driver must be installed. The 
driver can be found at the following location: 

http://www.postgresql.org/ftp/odbc/versions/msi/ 

 

Download the most recent version, choose a mirror to download from, unzip and execute the ‘psqlodbc.msi’ installer 
package. 

Once installed, open up a command prompt and execute the following command: 

 

A new window will appear displaying the data sources that are currently defined on the system. The psqlODBC 
driver can now be used to create a new data source for the SIMPLer server. 
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Click the “Add…” button. 

 

Scroll down the list to find the “PostgreSQL Unicode” driver, highlight it, and click “Finish”. A new dialog box will pop 
up allowing the user to define the data-source. The details need here can be obtained by your Azotel contact. 
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The Server IP should be 10.8.0.1 as access to the DB is only allowed over the secure VPN tunnel. Once the 
details have been entered, click the “Test” button to check the connection with SIMPLer. 

 

If the connection has been successful, click “Save”. The new data-source should be listed now, similar to below. 

 

Finally, click “OK”. 
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2.3 Configure Crystal Reports 
Open Crystal Reports. The user will be presented with the “Start Page”. 

 

To configure a connection to the SIMPLer server, click on “File” and choose “Log On or Off Server” from the 
dropdown menu. 
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Click on the + sign beside “Create New Connection” and then click on the + beside “ODBC (RDO)”. 

 

Choose the Data Source that was created in section 2.2, and click “Next >”. 
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Enter the database login credentials as provided by your Azotel Contact, and click “Finish”. 

 

The new data source will appear in the Data Explorer window and is now available to Crystal Reports. 
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3 Creating a Report 
The following section provides a walk through of how to create a simple report in Crystal Reports. The report we will 
generate will show how much revenue has been obtained per product. 

3.1 Gathering the Data 
From anywhere in Crystal Reports, click on “File”, go to “New” and then choose “Standard Report”. This will open up 
the Standard Report Wizard. 

 

 

Choose the appropriate data source such as “SIMPLer Zone 1” in the screenshot above either under “Current 
Connections” or “ODBC (RDO)”.Clicking on the + sign beside the entry will bring up the list of tables in this 
database. However, we are going to create our report by inputting SQL directly in to Crystal Reports. To do this, 
double click on the “Add Command” item underneath “SIMPLer Zone 1”. 
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Enter in the SQL query as it appears in the screenshot above i.e. SELECT product, sum(amount_nett) FROM 
invoice_position GROUP BY product. This query will retrieve the sum of the amounts of each invoice item 
grouped by the product it refers to. Click OK to confirm. 

 

The custom command has appeared now in the “Selected Tables” area. Click “Next >” to continue. 
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Next, we need to select the database columns that will be displayed on the report. Since we only SELECTed two 
columns from the database, we only have two to choose from. We want to display both the product’s description 
and the total revenue from it so copy both fields to the right hand side by clicking the “>>” button. 

 

We don’t need to give any more details to generate this report so click “Finish”. 

We will now be presented with a preview of the report. 

 

It doesn’t look very impressive just now but we can start making it look more professional very easily. Crystal 
Reports comes with some templates to help improve the appearance of its reports. To use a template, go to the 
“Report” menu and click “Template Expert..”. 
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Choose a template from the list and click OK. 

 

The next thing we can do is fix up the labels. Click on the “Design” tab to make changes to the layout of the report. 
By changing the fonts, and moving the label to the “Page Header b” section, we can improve the look and end up 
with something similar to the screenshot below. 
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Switching back to “Preview” mode gives us the following. 

 

3.2 Adding Graphics 
In Crystal Reports it is very easy to add graphs and chart to your report. This next section will describe how to 
present a pie-chart of the data we have gathered. 

Firstly, to use the “Product Description” field in our chart, we need to make it usable. Crystal Reports doesn’t allow 
columns of type “memo” to be used in some cases. To get around this restriction, we can create a formula field that 
will return the column that we need. To do this, right click on “Formula Fields” in the “Field Explorer” window, and 
click “New..”. Enter a name for this – we can just call it “product”. The “Formula Workshop” window will appear. 

 

Double click on “Command.product” which can be found under “Report Fields”. This will tell Crystal Reports to 
return this value for this field. Click “Save and close”. Now we can create our chart. Click on the “Insert” menu and 
select “Chart..”.  
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Crystal Reports will then allow the user, using an orange box, to choose the position of the chart. Place the chart in 
a suitable location such as underneath the data. The “Chart Expert” window will now appear. 

 

From here we can tell Crystal Reports using the rule: for each record of product, show the value of sum. Next we 
can choose which type of chart we want to display. 
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For the purposes of this example, we will choose a pie chart, with depth effect. Click OK to finalise the chart 
settings. Our report now appears like this: 

 

Of course, the chart is much more customisable that just this. We could, add a more descriptive title, change the 
colours of the pie slices, add a border etc. 
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4 More Advanced Reporting 
4.1 Revenue per Site Example 
As a more complicated example, we will create a report that will: 

• List each site defined in SIMPLer 

• Display how many customers each site has 

• Display how much revenue is generated from each site 

Having examined the database schema, we can see that four tables are needed to generate this information: site, 
customers, subscription, and products. 

We will approach this problem is three stages. First we will create a query to get a list of the sites and the number of 
customers associated with that site: 

SELECT  

siteid, 

COUNT (c.*) AS number_of_customers 

FROM  

site s,  

customers c 

WHERE s.siteid = c.siteid 

GROUP BY s.siteid; 

Query 4.1 – Site IDs vs. Number of Customers 

Next, we will create a query to get a list of the sites and the revenue generated by that site: 

SELECT  

siteid, 

SUM (p.productprice) AS revenue 

FROM  

site s,  

customers c,  

subscription su,  

products p 

WHERE  

s.siteid = c.siteid AND  

c.customerid = su.customerid AND  

su.productid = p.productid 

GROUP BY s.siteid; 

Query 4.2 – Site IDs vs. Revenue 
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Finally, we can combine the two queries as follows: 

SELECT ( 

SELECT sitename FROM site WHERE siteid = a.siteid) AS sitename, 

a.number_of_customers,  

b.revenue 

FROM ( 

SELECT  

siteid, 

COUNT (c.*) AS number_of_customers 

FROM site s, customers c 

WHERE s.siteid = c.siteid 

GROUP BY s.siteid 

) a, ( 

SELECT  

siteid, 

SUM (p.productprice) AS revenue 

FROM  

site s,  

customers c,  

subscription su,  

products p 

WHERE  

s.siteid = c.siteid AND  

c.customerid = su.customerid AND  

su.productid = p.productid 

GROUP BY s.siteid 

) b 

WHERE a.siteid = b.siteid; 

Query 4.3 – Site Names vs. Number of Customers & Revenue 

Create a new report using the “Standard Report Wizard”, select the correct data source, and add a new command 
using the combined SQL query (4.3) above. 



AZOTEL S04-03 v100 (2013-06) 
 

Azotel Confidential Proprietary 
© Azotel Technologies Ltd 2024 

 

 

Add all available fields to the report, i.e. sitename, number_of_customers and revenue. No other set up for this 
report is need so just click “Finish”. 

 

Note that we are again presented with a very basic report. The first two things that stand out are that the 
“number_of_customers” column is displayed as a decimal and the “revenue” column has no currency sign to signify 
that it is a monetary value. We can fix this by clicking on the “Design” tab, right clicking on the 
“number_of_customers” or “revenue” entry in the “Details” section, and choosing “Format Field”. 
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In the case of the “number_of_customers” field, choose the “(1,123)” style. For the “revenue”, simply tick the 
“Display Currency Symbol” checkbox. Crystal Reports will automatically use the system default currency, but this 
can be overridden by clicking on the “Customize..” button.  

 

Return to the “Preview” mode to ensure that the changes were successful. Next, we will use a template as a quick 
way to add some colour and some headings to the report. In this walkthrough we will use the “Corporate (Green)” 
template. 
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Go back in to “Design” mode and play around with the section sizes until they are appropriate. You will notice that 
there are no column headings now, but we can easily add them by right clicking on the column entry and choosing 
Insert > Field Heading. 

This will place a heading in the Page Header section, but we must also copy it to the Report Header section. Finally 
if we change the font size and colour of the headings, we can create something like this: 

 

An obvious extra useful column here would be how much revenue is generated per customer for each site. We can 
easily add this to out report. Right click on the “Formula Fields” item in the “Field Explorer” and click “New..”. 

 

Choose a name for the formula like ‘Revenue per Customer’. The Formula Workshop windows will appear next. 
Enter the formula you wish to use – in this case it will be: 

{Command.revenue} / {Command.number_of_customers} 
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You can use the sub windows to enter this formula automatically. To do this, double click on “Command.revenue”, 
then double click on “Divide (x / y)”, and finally double click on “Command.number_of_customers”. Click “Save and 
close” to finalise your changes. 

“Revenue per Customer” now appears under Formula Fields. When in Design Mode, we can drag this field in to our 
report. If we do this, add a heading similar to the other headings, and add a currency symbol as before, we will get 
something like this: 

 

Which is “Preview” mode looks like this: 

 

Now, in order to visualise the data, we will add a couple of graphs. First we need to add a formula field for “Site” just 
like we did for the previous report. Once that is done, we can create the graph. Click on the “Insert” menu, followed 
by “Chart..”. Select an appropriate place on the report to put the chart. 
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For the first graph we will create a bar chart of revenue per site. Use the chart expert as shown above to create this 
graph. Click OK, and repeat the steps to insert a graph. We will also create a graph of number of customers per 
site. 

 

For the second graph, just replace “Command.revenue” with “Command.number_of_customers”. Click OK. Back in 
preview mode, we can resize the graphs and place them side by side. We can also remove the legend as it is not 
really necessary in this case. To do this, right click on a graph, and choose the “Chart Options..” item. Go to the 
“Legend” tab and untick the Show Legend checkbox. 
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While in the Chart Options window, we can also fix up our titles. Go to the Titles tab, and add whatever titles are 
appropriate for your graph. 

 



AZOTEL S04-03 v100 (2013-06) 
 

Azotel Confidential Proprietary 
© Azotel Technologies Ltd 2024 

 

Click OK to confirm your changes. One final thing we can do to this report is to give it a description. Go to the 
Design tab and double click on where it says Report Description. This will allow you to edit this text box. Fill in the 
description and click off the text box to save the changes. 

 

4.2 Flexible Dates 
Suppose we want to generate a report of all customers who have joined in the last month. The Crystal Report tool 
needed for this is the “Select Expert”. Here are the steps involved to do this. 

Open up the Standard Report Creation Wizard. 

When choosing the data that you wish to report on, select only the “customers” table. 

Choose the customer fields that you wish to display. In this example we will just choose “name” and “start_date”. 

Choose a template if required, and click Finish. 
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To view a list of customers who only joined during a certain period, click on the “Report” menu and choose “Select 
Expert” from the drop down list. 

 

Choose the “startdate” column and click OK. 

 

Choose the criteria for the “startdate” column. In the screenshot above we have chosen the customer’s start date to 
be between the 2nd of November and the 9th of November. Click OK to confirm. 
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A dialog box will appear asking do we want to refresh the data from the database. 

 

Clicking on the “Refresh Data” button we cause the query to be executed on the server again, while clicking “Use 
Saved Data” will not. 

We can now see that the returned records have been filtered to just include those that meet our criteria. 
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Annex A: References 
A.1 Document References 
10025 SIMPLer Database Structure 

A.2 Link References 
http://www.azotel.com – Azotel Website 

http://crystalreports.com/ – SAP Crystal Reports Website 

http://jasperforge.org/ – Jasper Reports Website 

http://www.crystalreportsbook.com/forum/ - Useful Forum for Crystal Reports 

 

Annex B: Definitions & Abbreviations 
B.1 Definitions 
 

B.2 Abbreviations 
SIMPLer Subscriber Information Management Platform from Azotel 
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